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A. Document overview 

A.1. The exam documents 

There are 5 exam documents, 3 in PDF format and 2 in Microsoft Word format: 

Instructions_IPEdExam2024.pdf – the general instructions document 

K_IPEdExam2024.pdf – the KNOWLEDGE (K) part document 

L_IPEdExam2024.pdf – the LANGUAGE (L) part document 

M-E_IPEdExam2024.docx – the “Extract” document for the MANUSCRIPT (M) part 

M-S_IPEdExam2024.docx – the “Style sheet” document for the M part. 

This document covers how to use Acrobat to complete the PDF documents used in the L and K parts 

and how to use Word to complete the M part.  

A.2. The exam resources  

You will have access to both PDF and Word versions of the IPEd standards for editing practice 

(3rd edn) in your exam folder on your computer. The instructions for using Word and Acrobat apply to 

the respective version you decide to use.  

You may also use a web browser to access the 4 online resources – Macquarie dictionary online, 

Te Aka Māori dictionary, Biotext content manual (formerly Australian manual of style) and Australian 

Government style manual.  

Only the Macquarie dictionary online requires a subscription for access. You can login using your own 

account credentials or the generic IPEd exam account that the invigilators will provide on exam day.  

This document does not cover how to use web browsers generally or the online resources 

specifically.  

A.3. The standard of technical knowledge required  

You do not require advanced or specialist knowledge of Word, Acrobat or web browsers to use the 

exam documents, but you are expected to be “up to date and proficient” in:  

• common word-processing software for editing (IPEd standard A7.1), namely Word and PDF files 

• accepted techniques for handling digital files and protecting data (standard A7.3), specifically 

being able to access folders on a computer and to open, save and rename files 

• style guides and other references appropriate to the genre and content (standard A7.6), in this 

case the general style manuals and dictionaries provided as exam resources 

• standard tools and conventions for copyediting and proofreading mark-up, including the tracked 

editing and comment functions used in digital formats (standard A7.7), i.e. using Track Changes 

and Comments in Word in the M part.  

This guide assumes you already have some familiarity with using Word and PDF files on a computer. 

It provides instructions for using the exam documents in ways that are specific to the accreditation 

exam in 2024.  
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B. Preparing the documents 

This section covers the steps you will take in the preparation period (i.e. before reading time begins).  

B.1. The exam folders  

Your exam computer will show 3 folders on the desktop, similar to the desktops shown in Figure 1 

(Windows) and Figure 2 (Apple). These folders are preloaded on Cliftons venue computers. Remote 

and alternative venue candidates will receive separate instructions for downloading the folders on 

exam day.  

 

Figure 1. Windows desktop at Cliftons venue showing the 3 pre-loaded exam folders.  

 

Figure 2. Apple iMac desktop at Cliftons venue showing the 3 pre-loaded exam folders. 
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The 3 folders are:  

• WORKING_IPEd_exam_files. This folder contains the 5 exam documents that you will use to 

complete your exam. It is this folder and its contents that is discussed in the sections that follow. 

• Backup_IPEd_exam_files. This folder contains a backup copy of the 5 exam documents, and is 

only there in case something catastrophic happens to your working exam documents. You can 

safely ignore this folder. If something does go wrong with one or more of your exam documents, 

wait for an invigilator to help you before using any backup files.  

• IPEd_standards. This folder contains the 2 versions of IPEd standards for editing practice 

(see A.2. The exam resources).  

B.2. Renaming the working folder and exam documents  

The first stage is renaming the WORKING folder with your candidate number, and then renaming all 

the documents within that folder with an underscore followed by your candidate number.  

Note: The examples that follow use candidate number 24004. Make sure you use your own 5-digit 

candidate number. 

Warning! Contact the exam coordinator – admin if you have not received your candidate 

number by 1 August.  

Windows 

For the WORKING exam folder:  

1.  Select the WORKING folder without opening it. 

2. Right click on the folder name. A drop-down menu will appear. Select Rename. 

   

Alternatively, just position your cursor in the folder name and click so that it becomes editable.  

3. Type your 5-digit candidate number as the folder name. It should look like this (but with your 

own candidate number):  

 

4. Open the folder in File Explorer. You should see the 5 exam documents.  

mailto:exam.administration@iped-editors.org
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For each exam document in your candidate folder: 

1. In File Explorer, select the file without opening it. 

2. Right click on the file name and select Rename from the drop-down menu, or just click into the 

file name so that it becomes editable. 

3. Position your cursor at the end of the file name, without selecting or deleting the file name that 

is there.  

4. Type an underscore at the end of the file name (hold the Shift key while typing the hyphen 

key) followed by your candidate number, leaving no spaces in the file name.  

5. Repeat for each document. When finished, your candidate folder should look something like 

the folder shown in Figure 3 (but with your own candidate number at the end).  

 

Figure 3. Exam working folder in Windows for candidate 24004, with all 5 exam documents renamed with the 
candidate’s number.  

Apple 

For the WORKING exam folder:  

1.  In Finder, go to the WORKING folder and make the folder 

name editable either by clicking in the current folder name 

or using control-click to bring up the drop-down menu and 

selecting Rename. 

3.  Type your candidate number as the folder name. It should look like this (but with your own 

candidate number):  

 

4. Open the folder in Finder. You should see the 5 exam documents.  

For each exam document in your candidate folder: 

1. In Finder, make the file name editable either by clicking in the current file name or using 

control-click to bring up the drop-down menu and selecting Rename.  

2. Place your cursor at the end of the file name but before the file extension.  

3. Type an underscore (hold the Shift key while typing the hyphen key) followed by your 

candidate number, leaving no spaces in the file name.  

4. Repeat for each document. When finished, your candidate folder should look something like 

the folder in Figure 4 (a) list view or (b) icon view (but with your own candidate number).  
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(a) Folder list view    (b) Folder icon view 

Figure 4. Exam working folder in Apple for candidate 24004, with all 5 exam documents renamed with the 
candidate’s number. 

B.3. Preparing the Instructions document 

The next stage in preparation is entering your information – your candidate number and your choice 

of style guide – in the general instructions document Instructions_IPEdExam2024_##.pdf (where ## 

represents your own candidate number).  

Note: The methods in this section are the same for both Windows and Apple systems.  

To begin, open the file using Adobe Acrobat (and not another application). 

Warning! Apple users especially should check the PDFs have not opened in Preview. If 

your PDFs are not opening in Acrobat, ask your invigilator for help in setting Acrobat as the 

default PDF application on your computer.  

Entering your candidate number 

1. At the top of the first page, beneath the title “Instructions to candidates”, you will see an 

instruction to enter your candidate number above a coloured box, as shown below:  

 

2. Place your cursor in the box, which will turn white when you have clicked into it. Type your 

candidate number inside the box.  

 

3. Move your cursor out of the box and click on any other part of the page. You will know you 

have left the box when it turns coloured again.  

4. Save the file. (See C.5. Saving the files for different ways to do this.) 

Warning! Some systems might ask you to Save As, instead of just saving the file. If this 

happens to you, save the file under the same name in the same folder (i.e. your working 

exam folder which now has your candidate number) and click Yes when asked to confirm 

that you want to replace the existing file. Do not make a copy of the file somewhere else.  
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Indicating your choice of style guide 

1.  Scroll down to the radio buttons about halfway down the first page: 

 

2. Select the button next to your choice of style guide – A, B, C, D or E – by clicking on it.  

3. If you selected D for “other commercially available style guide”, enter the full title and edition 

of the style guide in the text box. You do not need to use italics for titles here. For example:  

New Hart’s rules: the Oxford style guide, 2nd edition 

If it is an online style guide (you will need a printout of relevant pages for use in the exam), 

don’t forget to include the URL. For example:  

Chicago manual of style online, www.chicagomanualofstyle.org 

4. Click out of all text fields or buttons and Save the file.  

Checking your changes have saved 

This step is to check that your entries in the form fields are saving properly.  

Warning! Do not skip these steps. If changes to the file are not saving correctly, you need 

to find out immediately – it will be too late to close a file at the end of the exam and realise 

your changes have not been saved.  

1. Close the file.  

2. Re-open the file and check that your candidate number is in the box and your choice of style 

guide is showing as selected. If you selected D, check that the title and edition you entered 

are there.  

If your changes haven’t saved, alert an invigilator and repeat the steps under their direct 

supervision so they can troubleshoot the problem for you.  

3. Close or minimise the file. (If the system you are using is slow to open applications or files, 

you can leave the file open but minimised.) 
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B.4. Preparing the L and K part documents 

The steps for preparing the L and K part PDF files are exactly the same (and very similar to the steps 

for the Instructions file). When you have finished preparing the L part document, move on to the 

K part document.  

Entering your candidate number 

Open the file. Like the Instructions document, the box for entering your candidate number is on the 

first page below the title. Do not go past this first page until instructed to do so by your invigilator.  

Repeat the steps for the entering your candidate number that you used for the Instructions file.  

Optimising your PDF settings 

This step is optional. The preparation period is the best time to adjust your view and navigation 

settings to enable you to move easily through the exam documents, although you can do this at any 

time during the exam.  

Everyone’s preferences are different and there is no “right” way to do this. The various options and 

recommendations are set out in C. Using the PDF files. You should practise with the sample exam 

files and decide what works best for you, make a list of the settings you want to adjust and the steps 

you need to take, and bring this into the exam in your bound notes.  

Note: You may need to adjust the settings for individual PDF documents. On the down side, that 

means doing the steps twice. On the up side, that means you can use different settings for different 

documents, if that suits you.  

Warning! Be careful not to go past the first page when you are making these changes in 

preparation time.  

Checking your changes have saved 

When you have finished entering your candidate number and adjusting your settings in the PDF 

document, you should close and reopen it. Follow the same steps as for the Instructions file.  

Closing or minimising Acrobat 

Before you move on to the M part documents in Word, your PDF files should be closed or minimised.  

Minimising is recommended if your system is slow to open applications or files.  

Some systems minimise Acrobat when you minimise individual PDF files, and some systems 

minimise only the files, leaving the Acrobat app itself visible. If only the individual files are minimised, 

you should also minimise Acrobat itself, for ready access when needed again.  
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B.5. Preparing the M part documents  

The steps for preparing the M-E and M-S documents in Word are the same, except that some 

optimisation settings are different. Start with the M-E file. When you have finished preparing the M-E 

document, move on to the M-S document and repeat the steps.  

Entering your candidate number 

Open the file in Word. Do not go past this first page until instructed to do so by your invigilator.  

1. At the top of the first page, below the title of the part component – “Extract” or “Style sheet” – 

you will see an instruction to enter your candidate number above a bordered text box (not a 

form field), as shown below:  

 

2. Place your cursor in the text box and type in your candidate number.  

 

3a. In the “Extract” (M-E) file only, check that Track Changes is on. If Track Changes is 

already turned on, your candidate number will appear as an insertion. If Track Changes is not 

turned on, go to the Review tab and turn it on, as shown in the Apple and Windows 

screenshots below left and right, respectively (older versions of Word may look different).  

    

3b. In the “Style sheet” (M-S) file only, check that Track Changes is off, as shown in the Apple 

and Windows screenshots below left and right, respectively.  

   

4. Save the file.  

Optimising your Word settings  

The preparation period is the best time to adjust Word settings for your preferences, although you can 

do this at any time during the exam. The next section covers one setting – autocorrect in tables – that 

we recommend you check in the M-S file.  

But there are other settings you might want to optimise in both M-E and M-S files, such as spelling, 

grammar and other autocorrect settings. Everyone’s preferences are different and there is no “right” 

way to do this. You should practise with the sample exam files and decide what works best for you, 

make a list of the settings you want to adjust and the steps you need to take, and bring the list into the 

exam in your bound notes.  

Warning! Be careful not to go past the first page when you are making these changes in 

preparation time.  
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M-S file – autocorrect in tables 

The style sheet template is set up as a Word table. By default, Word is set to automatically capitalise 

the first word in a table cell. As capitalisation is an aspect of style, this means Word will override any 

of your style decisions that are lower case, unless: 

• you manually retype over the automatically capitalised word, or 

• you turn off automatic capitalisation.  

At Cliftons venues, the invigilators should have turned this autocorrect setting off already, 

but you might want to check the setting yourself. You might even prefer to have autocorrect on. 

If you are not at a Cliftons venue you will need to do this step yourself.  

The instructions for both Apple and Windows are set out on the following pages.  

Apple 

To turn this aspect of autocorrect in tables on or off:  

1.  Go the main Word menu and select Preferences.  

2. In the Word Preferences panel that appears, under Authoring 

and Proofing Tools, select AutoCorrect. 

 

3. In the list of options that appears in the next panel, find Capitalise first letter of table cells 

and select or deselect it according to your preference.  

 

4. Optionally make any other adjustments to autocorrect settings according to your preferences. 

When you are finished, just close the panel.  
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Windows 

To turn this aspect of autocorrect in tables on or off:  

1.  Go to File then in the long panel that opens select Options (see screenshot at 

right, near the bottom).  

2. In the Word Options panel select Proofing. The proofing options will appear in the 

same panel. 

 

3. Under the heading AutoCorrect options select the button AutoCorrect Options… 

(shown above).  

4. In the panel that opens, uncheck (or check) the box next to Capitalize first letter 

of table cells, according to your preference. 

 

5. At the bottom of this panel, click OK.  

6. Back in the Proofing area, click OK again.  

Checking your changes have saved 

When you have finished entering your candidate number and adjusting your settings in the Word 

documents, you should check your files are saving properly.  

1. Close the file.  

2. Re-open the file and check that your candidate number is in the box. If your change hasn’t 

saved, alert an invigilator and repeat the steps under their direct supervision so they can 

troubleshoot the problem for you.  

3. Close or minimise the file. (If the system you are using is slow to open applications or files, 

you can leave the files open but minimised.) 
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C. Using the PDF files 

This section explains how to navigate and move around within the PDFs, how to enter your answers 

in the L and K part documents, and different ways to save the files.  

C.1. Getting started 

The Instructions, K and L documents are all fillable PDF forms. You will use Adobe Acrobat, pre-

installed on your computer, to open and complete these documents.  

Acrobat’s newer interface 

Acrobat has a newer interface (Figure 5). The instructions that follow are based on this interface 

because that is what Cliftons will provide in most cases. If you are more comfortable using the older 

interface (Figure 6), you can easily switch back. The instructions are the same, but the menu 

locations will be in the places you are familiar with. It is your choice which interface you use.  

 

Figure 5. Initial view of a PDF in the newer Acrobat interface, showing the tools panel on the left and the 
bookmarks panel on the right.  

 

Figure 6. Initial view of a PDF in the old Acrobat interface, showing the bookmarks panel on the left and the tools 
panel on the right.  
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Switching between interfaces – Windows 

To revert to the old interface:  

1. Go to Menu and select Disable new Acrobat Reader (or equivalent wording depending on your 

version of Acrobat) (Figure 7).  

2. You will be prompted to restart Acrobat. Click Restart.  

 

3. Open the file again. You should now see the layout shown in Figure 6. 

To enable the newer interface:  

1. Go to View and select Enable new Acrobat Reader (or equivalent wording) (Figure 8).  

2. When prompted, click Restart. 

3. Open the file again. You should now see the layout shown in Figure 5. 

 

Figure 7. Disabling the new interface under “Menu”. 

 

 

 

 

 Figure 8. Enabling the new interface under “View”.  
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Switching between interfaces – Apple 

The location for disabling or enabling the newer interface is under the View menu in both interfaces.  

1. Go to View and select Disable new Acrobat or Enable new Acrobat, as required.  

 

2. When prompted to Restart Acrobat, select Restart.  

 

3. Open the file again. You should see the layout shown in Figure 5 if you enabled new Acrobat, 

or the layout shown in Figure 6 if you disabled new Acrobat. 

C.2. Optimising your screen view 

Before you begin work, you may want to adjust the view to optimise working in the files. Choose what 

works for you, remembering you can change this at any time during the exam.  

Closing the “All tools” panel 

Acrobat has the “All tools” panel open by default, which takes up a lot of valuable screen space. 

You will not need to use any of Acrobat’s tools in the exam – including the “Add comments” tool, 

because no commenting or markup is required in the PDFs, as explained in C.4. Completing the 

questions. That means you can close this panel and forget about it.  

To close the “All tools” panel In both Windows (left screenshot below) and Apple (right screenshot 

below), simply click on the small cross at the top right corner of the panel. Note: You may need to do 

this in each document and each time you re-open a document.  
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Enabling scrolling 

If you like to be able to scroll smoothly through a PDF, you might want to enable scrolling.  

Note: You will need to do this in each PDF document.  

In Windows:  

1. Go to Menu then View then Page display and click on Enable scrolling.  

 

2. To disable scrolling, simply repeat step 1 (you will see a tick mark next to “Enable scrolling” 

showing it is enabled).  
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In Apple:  

1. Go to View then Page Display and click on Enable scrolling.  

 

2. To disable scrolling, simply repeat step 1 (you will see a tick mark next to “Enable scrolling” 

showing it is enabled).  

 

C.3. Navigation – finding your way around the exam documents 

There is more than one way to navigate and move around the exam PDFs in Acrobat: using search; 

view and page shortcuts; bookmarks; and text navigational aids embedded in the content.  

Search 

In the top panel towards the right is a search icon, which looks the same in both Windows and Apple: 

  

Clicking on it will bring up the search panel:  

 

You can enter your search term in the box or click on the three dots to bring up the options to refine 

your search. The only difference between Windows (left) and Apple (right) is the “Replace text” option, 

which you will not need to use in the exam.  
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View and page shortcuts 

On the very right-hand edge of the newer interface is a narrow panel that contains some icons at the 

top and some icons at the bottom. Those at the bottom (shown at right) are the view and page 

shortcuts (in the old interface, these were in a central panel at the top). They are the same in both 

Windows and Apple.  

These are, from top to bottom:  

• The current page number. You can type a number into the box to take you to that page.  

• The total number of pages in the document.  

• An up arrow. Clicking on that arrow will take you back to the previous page.  

• A down arrow. Clicking on that arrow will take you to the next page.  

• A rotation icon. Clicking the icon will rotate the page through 90 degrees clockwise. (If 

you click this accidentally, keep clicking until the page has rotated through 360 

degrees, back to the starting position.)  

• A page icon. This is a shortcut to the page view options – including “Enable scrolling”. 

You can try these to see if there are options you prefer. 

 

• The zoom in icon (magnifying glass with a plus sign), to make the page bigger.  

• The zoom out icon (magnifying glass with a minus sign), to make the page smaller.  

Bookmarks 

Each of the exam PDFs is bookmarked to headings and subheadings, and, in the K and L 

parts, to question numbers.  

The exam PDFs are set by default to have the bookmarks showing. In the top of the far right 

panel is a bookmarks icon (shown at right). Clicking on that icon will open and close the 

bookmarks panel.  

It is a good idea when first opening the document to scan the bookmarks to get an idea of the 

document’s contents. Then you can close the panel until you need it again, for example to 

navigate quickly to a particular heading or question.  
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Nested headings and sub-questions are shown by an arrow icon to the left of the bookmark. In the 

example below from the L part PDF, you can see arrows pointing towards the right next to the 

headings for the Copyediting questions and the Multiple-choice questions.  

 

Clicking on these arrows will reveal the bookmarks for the headings and sub-questions nested below 

those headings:  

    

To go to a particular heading or question, just click on the bookmark and you will be taken straight to 

that section of the document. 

Text navigational aids in K and L parts 

The exam PDFs contain three sets of navigational aids built into the content to help you find your way 

around the documents: running headers, question markers and hyperlinks.  

Running headers 

Each document has a running header that tells you which document you are in and the page number. 

In the K and L part documents, there is additional information in the form of a large K or L so you can 

see at a glance which part you are working on, the section or question, and the specific sub-question 

number on that page.  

The running header pictured in Figure 9 shows that this is page 4 of the LANGUAGE part document 

of the 2024 exam, there are 6 pages in total in the part, and that page 4 contains questions 8 to 13.  
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Figure 9. The running header on page 4 of the LANGUAGE part document in the 2024 exam.  

The running header pictured in Figure 10 shows that this is page 13 of the KNOWLEDGE part 

document of the 2024 exam, there are 36 pages in total in the part, and that page 13 contains sub-

questions 2.5 and 2.6.a of question 2. 

 

Figure 10. The running header on page 13 of the KNOWLEDGE part document in the 2024 exam.  

Question markers (K part only) 

In the K part document, the start of a question is always on a new page and is shown in a large 

heading, for example:  

  

However, many sub-questions span 2 or more pages – in the example above, only 3.1.a and 3.1.b 

are on this page; sub-question 3.1 continues on the next page. That there is more to a sub-question is 

shown at the bottom of the page:  

 

Then at the top of the next page, below the running header, a “continued” marker shows which sub-

question the questions on that page belong to:  

  

The end of a question is also marked by specific text to that effect, for example:  

 

Hyperlinks 

At the bottom of every page and at the end of every question, internal hyperlinks direct you to key 

sections of the document. Simply click on a hyperlink to go to that section.  
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The L part PDF has links to the formatting, special character and keystroke guidelines on page 2 of 

the document, as well as links to the start of the copyediting questions and the start of the multiple-

choice questions (Figure 11). 

 

Figure 11. Internal hyperlinks at the bottom of each page in the LANGUAGE part PDF.  

The K part PDF has links to the “KNOWLEDGE questions – summary list” on page 2 of that 

document, the keystroke guidelines on page 3, and the “Answer(s) continued” pages at the end of 

the document (Figure 12).  

 

Figure 12. Internal hyperlinks at the bottom of each page in the KNOWLEDGE part PDF.  

The “KNOWLEDGE questions – summary list” also has links to each of the 6 main questions in the 

part and to the “Answer(s) continued” pages. A quick way to go to a particular question is to click on 

the hyperlink to the summary list and then click on the question number.  

A very few sub-questions also have hyperlinks. For example, if there is a scenario set out at the start 

of a sub-question that spans more than one page, subsequent pages that make use of the scenario 

will have a link to the scenario so you can get there quickly instead of having to scroll back.  

C.4. Completing the questions 

You will complete the questions in different ways, depending on the format of the question.  

Possible question formats are: 

• short answer – type directly into the text box 

• long answer – type directly into the text box 

• editing text – edit the text in the text box or select the OK box if there are no edits needed 

• multiple choice – select radio buttons  

• true/false – select radio buttons 

• sort items into an order or hierarchy – enter the number or hierarchy level in the box next to the 

item.  

Keystroke guidelines 

For any questions that include editable text fields (shown as boxes), you can apply rich text formatting 

(bold, italics, underline) using keystroke shortcuts. You will also need to use keystrokes to insert 

different kinds of dashes. The exam documents include a keystroke guidelines section at the start 

(page 2 of L part and page 3 of K part), which you can find via the bookmarks panel or by clicking on 

the hyperlink at the bottom of the page. The PDFs generally don’t allow you to type curly (“smart” or 

“typographer’s”) quote marks – they will appear straight. The examiners are aware of this, so don’t 

waste time trying to type (or copy) curly quote marks.  
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L part questions 

The L part contains only 2 types of questions: editing text (questions 1–20) and multiple choice 

(questions 21–24).  

K part questions 

The K part contains most or all of the question formats listed above.  

For short answer and long answer questions, the size of the text box indicates the length of answer 

needed. However, if you feel you need more space to complete your answer, use the “Answer(s) 

continued” boxes at the end of the document (which you can get to by clicking on the link at the 

bottom of each page). 

If you use the “Answer(s) continued” sections, you need to let the markers know where to find the rest 

of your answer:  

• In the answer box for the question, write “see Answers continued”. 

• In the “Answer(s) continued” box, write the question number of the answer you are continuing. 

• In the question summary list on page 2, check the box next to “Answer(s) continued”.  

C.5. Saving the files 

First time “Save as” 

The first time you try to save your PDF files you will be prompted to “Save as …” (Windows) or 

“Save As” (Apple).  

1. The prompt screen will give you folder options for where to save the file. Make sure you select 

your exam working folder (i.e. the one named with your candidate number: see 

B.2. Renaming the working folder and exam documents).  

2. Keep the name of the file the same.  

3. When prompted, click “Yes” to replacing the file.  

Warning: Do not make multiple copies of your working exam files.  

Subsequent saves 

You can save the PDFs at any stage by using the usual keystroke command – Ctrl + S (Windows) or 

Cmd + S (Apple). Alternatively, you can go to the top panel and click on the Save icon:  

 

Note: The Save option is only available, and the icon will only appear:  

• if you have made a change in the file since your last save 

• when your cursor is not in a form field (as it assumes you are not finished entering your answer in 

the field).  

If you cannot simply save the file, you can always use the “Save as” option again. But if the issue 

persists, ask an invigilator to check your PDF settings.  
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D. Using the Word files 

You will complete the MANUSCRIPT part (M-E and M-S) in Microsoft Word. The version for both 

Apple and Windows computers at Cliftons venues will be Word 2021 (which is very similar to 

Office365 versions but does not require individual user login).  

If you are using a different version of Word, as long as it is recent (2016 or later) the functionality will 

be very similar to Word 2021.  

D.1. Word tools and add-ins 

You may use any Word tool that is a standard feature of Word, including spelling and grammar 

checks, apart from those that require internet access (such as some AI-enabled features).  

At Cliftons you will not have access to common Word add-ins such as PerfectIt or EndNote.  

If you are at another venue (e.g. sitting remotely), you will need to disable any add-ins before the 

exam. If you are unable to disable the add-in, your invigilators will be watching carefully to ensure you 

do not use any add-ins.  

D.2. Navigation 

The M-E and M-S files have fewer pages than the L and K files, so you should have no trouble finding 

your way around. 

Simply use whatever method you usually use to navigate or search in Word. The section headings will 

show up in the navigation pane if you open that panel to show the headings or outline view, as shown 

in the screenshots below (how this looks will depend on whether you use Apple or Windows as well 

as your version of Word):  

   

D.3. Using the MANUSCRIPT “Style sheet” document (M-S) 

You will type your style decisions directly into the boxes, which are table cells.  

In the “General notes” section, type all your entries into the same cell and just press the Enter key to 

start on a new line.   

In the alphabetical word-list section, move from one cell to another by pressing the tab key to move to 

the next cell, or position your cursor where you need it to be.  

You will not need to use Track Changes (but you can if you want to).  

Do not use Word’s Comments function to add any notes or queries in your style sheet.  

Warning! Remember to fix unwanted capitalisation manually if you did not turn off 

automatic capitalisation in tables (see M-S file – autocorrect in tables).  
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D.4. Using the MANUSCRIPT “Extract” document (M-E) 

You will make your edits to the extract using Track Changes and write author queries using 

Comments. Both these tools are found in the Review tab.  

Track Changes 

Settings 

The Track Changes settings should be set:  

• to show edits in line, with insertions in traditional blue and deletions in red strikeout 

• to show formatting changes and Comments in the margin 

• with the user name “Ed.” or “Author”.  

Leave these settings as they are.  

Warning! If the settings are not showing as described, ask an invigilator for help.  

Markup view 

While you work, you can toggle the Track Changes view between Simple Markup, All Markup or 

No Markup, whichever suits your preference. Some editors find it useful to do the edits in the 

All Markup view and then check how the edits look in the Simple or No Markup views.  

To toggle between views go to the drop-down menu in the Review tab and select the view you want.  

Alternatively, toggle between the All Markup and Simple Markup views by clicking on the coloured 

lines in the left margin. In the All Markup view the line is grey; in the Simple Markup view it is red.  

Warning! Always check that Track Changes is on and that you do not accidentally turn it 

off, or your edits will not be visible to the markers.  

Comments  

You will write author queries using Word’s New Comment function in the Review tab. Each new 

comment should appear in the margin.  

At Cliftons venues, modern comments will probably be enabled by default. You can switch to 

traditional comments if you prefer – it does not matter which version of comments you use.  

To enable or disable modern comments, as you prefer:  

1.  Go to Word Options (Windows) or Preferences (Apple).  

2. Go to the General section. 

3. Under User interface options (Windows) or Settings (Apple), select or deselect 

Enable modern comments.  

4. In Windows, click OK. In Apple, just close the panel.  

E. Troubleshooting 

If you have any technical difficulties with the files or your computer during preparation time or during 

the exam, ask an invigilator for help immediately and follow their advice.  
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